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Laptop Rentals and
Wireless Computing

� Laptop rental additions: Apple iBook and more locations
Now you can rent an Apple iBook; it comes equipped with the Apple Airport Card for
wireless Internet connection in various places around campus. And, of course, you can still
rent the Dell Inspirion Notebooks.

In addition to the 93 Blegen location, the laptop rental program is now available in the
Technology Helplines in 152 Shepherd Labs and 50 Coffey Hall. Rentals are still only for
one day, Monday–Friday, starting at 8:00 a.m.

For more information on renting laptops during the day, see this Website:
http://lighthouse.micro.umn.edu/laptoprental

� Wireless connections in Wilson
Those who are using wireless PCMCIA cards on campus can access the Internet in Wilson
Library on the West Bank where wireless Internet connections are available in the main study
areas. How does it work?

◗ Only PCMCIA cards that are registered through the DHCP service can use the
wireless connections, a step we’ve taken for all the laptops available through our
rental service. To register your own laptop, follow the DHCP link on the Net-
working and Telecommunications Website: http://www.nts.umn.edu

◗ Compatible laptops will access the Internet in the Wilson Library central study
areas, from the basement through the fourth floors.

� Peter Oberg, Office of Information Technology
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TEL Seminars
� Tues, noon – 1:30
� 140 Nolte Center

� April 10: A Virtual
Biomechanics Lab
• Victor Barocas,
Biomedical Eng.

� April 24: Evaluation
of Web-based
Courses: A Concep-
tual Approach
• Melissa Avery,
School of Nursing

www.umn.edu
/dmc/initiatives
/seminar-series

http://lighthouse.micro.umn.edu/laptoprental/
http://www.nts.umn.edu/
http://www.umn.edu/dmc/initiatives/seminar-series/
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E-mail Guidelines
� Don’t check too often
Did you know that checking for new e-mail too
frequently consumes a lot of resources and may
actually prevent you from receiving mail in a timely
manner? A surprising number of people’s e-mail is set
to automatically check for mail every minute or so.

We recommend checking for new e-mail no more than
once every 10-15 minutes, a frequency setting that
most full-featured e-mail software supports. (Figure 1).
We encourage you to set longer intervals. You can
override the automatic settings if you’re waiting for an
urgent message: select the “get new messages” option
from your e-mail client.

� Keep inboxes small
Those who use POP or IMAP protocols can leave mail
on the server in their Incoming Mail Server’s inbox.
(See January 2001 newsletter.) People who keep a
large volume of e-mail in the server’s inbox use more
resources than just the storage space they’ve been
allotted. When people clear out those inboxes, they are
frequently surprised at how much faster the system
works.

Whenever you fetch e-mail, even if
there is only one new message to
be displayed, the system must read
through every message in your
Incoming Mail Server’s inbox.
Then the mail server and the e-mail
client on your computer must
communicate with each other to
determine which messages you
haven’t seen yet, a process that gets
slower as the inbox gets bigger.
Large inboxes are the most com-
mon reason for perceived slowness
in the e-mail system.

Managing POP protocol
The POP protocol is the default setting for most
e-mail software. Some who use the POP protocol
select the “leave mail on the server option” without
realizing the mail is not actually deleted from their
Incoming Mail Server’s inbox. These people are
unaware that the server’s inbox is growing because
when they “fetch” mail they only get new messages;

and their software does not remind them that mes-
sages they’ve fetched, filed or discarded on their own
computers are still stored in the Incoming Mail
Server’s inbox.

The “leave mail on the server option” is appropriate if
you read mail from multiple computers, and you set
up one e-mail client to not save messages. It is also
appropriate if you occasionally use Webmail to clean
up the Incoming Mail Server’s inbox:
http://www.mail.umn.edu

Since POP protocol users who have more than 500
messages in their Incoming Mail Server’s inbox are
probably unaware of its size, we periodically send
them e-mail advising them to clean up the server’s
inbox or call the Technology Helpline to find out
what steps to take.

� Bad combination
People who check e-mail very frequently and who
also have large Incoming Mail Server inboxes will get
poor performance.

While your e-mail client software is checking/down-
loading mail, the system cannot deliver newly arrived
mail. As the inbox grows it is possible for the “fetch
new mail” operation to take more time than the
“check for new mail” interval, resulting in a loop
where that user never actually downloads all new
mail.

� Technology Helplines, Phil Kachelmyer,
Mary Kelleher

When people clear out their
inboxes, they are frequently
surprised at how much
faster the system works.

http://www.umn.edu/oit/newsletter/01/0101_itn/imap.html
http://www.mail.umn.edu/
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D on’t set up your software to automati-
cally check for new e-mail more often
than once every 10-15 minutes. Inter-

vals of 30 minutes or more are preferred; and even
longer intervals work for many people, as does
manually checking for new mail rather than using
the automatic setting.

Most e-mail software lets you set time in minutes.
Pegasus is one example that can set time in
seconds; Pegasus should be set to a minimum of
600 seconds.

To get help changing the timing setting you can,
of course, call the Technology Helpline. The exact
menu selections for any option tend to change
when software gets updated.

Sample settings are listed below.

M
Eudora

1. Mac OS: from the Special menu select Settings
2. Windows: from the Tools menu select Options

• Then from the scrollable icon list, select
Checking Mail.

• There you’ll find this entry:
Check for mail every __ minutes.

Type in the desired time interval. To turn this
feature on or off, click its checkbox.

M
Netscape Navigator or Messenger

� Netscape 4.0, 4.5 and higher

1. From the Edit menu, select Preferences.
2. In the Category box, click the plus sign or

arrow preceding Mail & Newsgroups and
select Mail Servers.

3. Then follow instructions below and remember
to click the OK buttons on all windows you
have opened.

� Netscape 4.5 and higher

• In the Incoming Mail Servers section, select the
mail server, then click the Edit button.

• In the resulting windows, select the General
tab and look for this entry:
Check for mail every __ minutes

Type in the desired time interval. To turn this
feature on or off, click its checkbox.

� Netscape Messenger 4.0.x

• Click the More Options box and look for this
entry: Check for mail every __ minutes

Type in the desired time interval. To turn this
feature on or off, click its checkbox.

M
Microsoft Outlook

� Outlook 2000, Windows, Internet only
option

• From the Tools menu, click Options.
• Select the Mail Delivery tab and look for this

option: Check for new mail every __ minute(s)

Type in the desired time interval.

� Outlook Express 5, Macintosh

• Click on the Tools menu and select Schedules.
• Look for the Send & Receive option and click

on the Edit button.
• In the When section you can set a repeating

schedule.

Which version of Outlook?
To find out which version of Outlook you have,
open Outlook. From the Help menu select About
Microsoft Outlook. In the resulting window, look in
the upper right-hand corner for the version num-
ber.

�

Figure 1: setting e-mail time limits
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Is your e-mail ugly and dangerous, too?
In June 2000 we reported that the Office of Information Technology’s (OIT) mail server
administrators are exploring whether the University can use antivirus software to check
e-mail messages without slowing the system down too much or imposing other drawbacks.
We’re still checking. But the results of a recent test should interest you.

Enclosures can be hazardous
The University’s central e-mail servers deliver about 3
million messages each week. Recently we’ve tested
some virus detection software on e-mail that passes
through these servers and found that more than
30,000 had enclosures with viruses. We think a 0.1%
chance of getting an obnoxious or hazardous virus
should make people cautious.

E-mail attachments are so common some people
routinely send all e-mail that way, a practice we’d like
to discourage.

Today you need to consider that every Microsoft Word
document could really be a small computer program,
thanks to macros, a useful way to automate routine
tasks — unless the macro is a malicious Melissa (a virus
that made headlines in the summer of 1999). Word
macro viruses are still one of the largest categories of
annoying and treacherous computer code.

If you use “Wordmail” or unthinkingly send Microsoft
Word documents instead of plain text, consider chang-
ing how you compose mail. Figure 1 has some steps
for turning off Wordmail.

The case for plain text messages
Not only is plain text safer, it is accessible to a broader
range of people.

Plain text means: no HTML and no word processing
documents. We get many examples of easy to read and
understandable plain text e-mail. Figure 2 has some
examples of plain text e-mail with short paragraphs and
blank lines between, making the text easy to read
without resorting to bold text or font changes.

Sending plain text mail is also good netiquette. Ugly
e-mail frequently shows up in electronic mailing lists
that include people who are used to exchanging e-mail
with colleagues who use exactly the same software that
they do; they may not realize that the rest of the world
uses a huge variety of e-mail programs.

Figure 1: Turn off WordMail

When Wordmail is enabled, Outlook or Exchange
will use Microsoft Word as the default e-mail
editor for new mail and forwarded mail.

To turn it off, follow your e-mail client’s instruc-
tions; representative samples are below.

� Outlook 2000, 98 and 97

• From the Tools menu, select Options, then...

� Outlook 2000

• In the Options dialog box, click the Mail
Format tab.

• Under Message format, deselect the Use
Microsoft Word to edit e-mail checkbox and
click OK.

� Outlook 98

• In the Options dialog box, click the Mail
Format tab.

• In the Send in this message format field,
select Plain Text and click OK.

� Outlook 97

• In the Options dialog box, select the Email
tab.

• Deselect the Use Microsoft Word as the
Email Editor checkbox and click OK.

Plain text is safer and

is accessible to a

broader range of people.
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Another way to fine tune your e-mail so that more
people can easily read it is to keep the line length
short, as shown in Figure 3. Long lines are difficult to
read, and some people still use 80-characters terminals.

Scary HTML e-mail
HTML enabled e-mail can also be hazardous.

SANS (System Administration Networking and Secu-
rity organization) and CERT (Computer Emergency
Response Team at Carnegie Mellon University) report
a vulnerability that allows viruses to be spread even if
an attachment is not opened.

“Email viruses are now spreading WITHOUT
THE USER OPENING ANY ATTACHMENT.
Personal computers running Internet Explorer
(IE) version 5.0 and/or Microsoft Office 2000 are
vulnerable to virus attacks using most HTML-
enabled email systems.”

• http://www.sans.org/newlook/alerts/virus.htm
• http://www.cert.org/advisories/CA-2000-07.html

Here’s another reason to use a plain text editor: it
won’t display HTML. It’s better to get ugly mail than
deadly e-mail. In March 2001 this vulnerability was
reported for Microsoft Internet Explorer 5.01 and 5.5

“it is possible for a web page or HTML e-mail to
learn the physical location of cached content.
Armed with this information, an attacker could
cause the cached content to be opened...”

http://www.microsoft.com/technet/security
/bulletin/MS01-015.asp

Figure 2
Good and ugly e-mail examples.

The good examples use plain text.

Ugly
<b><font color=”#FF1C68">Meeting
change.</font></b> New time is
<b><font color=”#9828FF”>1/2</
font></b> hour earlier.</li>

Good (March 2001 e-mail from Parking and
Transportation services)

Motorists on the Washington Avenue
Bridge are reminded to drive with caution.
Construction crews will be on the bridge
deck and near moving traffic. Remember
that all moving violation fines double in
work zones.

Please note that this construction project is
funded and performed by Hennepin
County.

Ugly
<DIV>At 7:56 PM -0800 12/25/00,
Marti wrote:</DIV>

<BLOCKQUOTE cite
type=3D”cite”><FONT face=3DArial
size=3D-1>When I read my post, I realized
I did not say what I had wanted to,
sorry.&nbsp;

<DIV><X-TAB>
&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
</X-TAB>I would suggest looking at a 3rd
party product

Good (February 28, 2001, Brief Newsletter)

TWIN CITIES—U has been selected by
IBM as one of a few sites in the U.S. for
the IBM Pieta Kiosk, an interactive com-
puter display dedicated to Michelangelo’s
Florentine Pieta. Kiosk, which is located in
Andersen Library, allows viewers to learn
about sculpture’s history and rich detail.
U’s Charles Babbage Institute also received
gifts from IBM: 3 desktop computers, 2
laptop computers, and a network printer.

Figure 3: Keep the line’s length short,
a Netscape Messenger example.

http://www.sans.org/newlook/alerts/virus.htm
http://www.cert.org/advisories/CA-2000-07.html
http://www.microsoft.com/technet/security/bulletin/MS01-015.asp
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Figure 4 shows you how to turn
off HTML mail, using Netscape
Communicator 4.5 as an example.

URLs still supported
Plain text does not mean you must
give up clickable Web addresses.

When you read e-mail in your
inbox or mail folders that contains
a Web reference like this

For more on accountability at
U, see http://www.umn.edu
/govrel/accountability.htm

you’ll still be able to click on it to
automatically go to that Website.

Today’s full-featured e-mail
software recognizes URLs (Univer-
sal Resource Locator), the stan-
dardized addressing scheme that
lets you access resources on the
Internet. As long as the text begins
with http://, the software can turn
it into a clickable hyperlink.

Keep your antivirus
software up-to-date
Even if the University purchases
and maintains centralized e-mail
scanning software, individuals will
still have to run antivirus software
on their personal computers.

Viruses and other malicious code
can be passed around via non-word
processing documents, Web pages,
security holes in workstations and
removable media such as diskettes
and CDs — and the scanning
software might not be able to scan
all encrypted encloses.

� Technology Helplines, Phil
Kachelmyer, Mary Kelleher

Figure 4: Turn off HTML formatted mail

This figure uses Netscape Communicator 4.5 as a representative
example.

1. From the Edit menu, select Preferences.
2. Click Formatting. If you do not see the Formatting option, click

the plus sign or triangle next the Mail & Newsgroups label.

3. The resulting window shows the formatting options below.

Related OIT newsletter articles

• Norton Antivirus Software (March 2001)
• Viruses: a Wake-up Call? (March 2001)
• E-mail Inboxes: POP or IMAP (January 2001)
• Computer Security @ Home (January 2001)
• A Growing E-mail Appetite (August 2000)
• Concerned About E-mail Viruses? (June 2000)
• Security and Shared Resources: Timely Reminders

(March 2000)
• E-mail: Self-serve Setup Instructions (August 1999)
• Netscape Mail – Servers and Signatures (September 1997)
• Viruses. Be aware. Be careful. (July 1997)

http://www1.umn.edu/urelate/govrel/accountability.htm
http://www.umn.edu/oit/newsletter/01/0301_itn/nav.html
http://www.umn.edu/oit/newsletter/01/0301_itn/wakeup.html
http://www.umn.edu/oit/newsletter/01/0101_itn/imap.html
http://www.umn.edu/oit/newsletter/01/0101_itn/security.html
http://www.umn.edu/oit/newsletter/0800-itn/email.html
http://www.umn.edu/oit/newsletter/0600-itn/viruses.html
http://www.umn.edu/oit/newsletter/0300-itn/security.html
http://www.umn.edu/oit/newsletter/0899-itn/self_serv.html
http://www.umn.edu/oit/newsletter/0997-itn/nsmail_tip.html
http://www.umn.edu/oit/newsletter/0797-itn/be_careful.html


April 2001 7

What’s your Web IQ?
Nancy K. Herther, University Libraries, http://www.lib.umn.edu

A re you hoping to do more of your research
using the Internet? Are you working on
class assignments that require Internet-
based research?

Learning to judge the Web and better evaluate its
value as a research tool, for information or enjoyment,
is not easy.

Students frequently stop in the Libraries with some
information they have found on the Web, seeking to
verify or get more information on a topic. Some Web
pages are very well-designed, even fancy; however, the
content is the key issue. Today, anyone who can create
a brochure can create a Website. Add a search feature
and many call their Websites databases. In reality many
are still not much more than brochures or resumes or
some type of promotional material. Developing
critical, discriminating skills to deal with today’s
expanding Web is not easy. Here are some tips that
might help you out.

❚❚ You see, but you do not observe. ❚❚

Sir Arthur Conan Doyle (Sherlock
Holmes), A Scandal in Bohemia, 1892

A rose by any other name
A Website, like brochures or any other type of publica-
tions, is intended as a form of communication. Web
pages generally fall into five categories or types.

1. Personal: these are Web pages created by an
individual – and many Websites that offer on-line
e-mail also offer their clients the ability to create
their own Websites as an option or perk for signing
up. These Websites may cover family history, give
resume/personal histories or other information;
and they can have a variety of endings in their
URLs (.com, .edu, .net and so on).

2. Business/Commercial: these can be the official
pages for some established company (such as Sony,
IBM, ADM, Microsoft) or a small start-up. These
sites can provide information for investors, product
information, services and other information. Often
these sites have a .com in the URL, but may have
.net or other identifiers instead.

3. Advocacy: just as any group can create a pamphlet
or brochure, so can it create a Web page. Some are
very well done and professional in appearance;
some are deceptively presented so that it is not
always easy to identify potential bias.

4. News: whether it is from an established news
group (a newspaper, televised news group, etc.) or
from an aggregator of some type (such as
pewinternet.org) covering links to information on
some particular subject or issue, this is a very
popular type of Internet site today.

5. Informational: governmental organizations,
schools, colleges and others have used the Web to
provide an additional avenue of communication
with their user groups. For instance, the
University’s class schedules are now on-line as are
IRS publications and legislative bill tracking. The
URL for these sites often have .edu or .gov but
may also have .net or other identifiers.

❚❚ If you put tomfoolery into a computer,
nothing comes out of it but tomfoolery.
But this tomfoolery, having passed
through a very expensive machine, is
somehow enobled and no one dares
criticize it. ❚❚ Pierre Gallois

Learning how to identify the source/producer of some
Website isn’t always easy. Are the responsible organiza-
tions and individuals listed? Do they give citations of
some sort for all of the information that they cite? Do
they carefully distinguish facts/information from
commentary/opinion? Is the Website kept up-to-date
as information and knowledge change?

For some good information on how to evaluate
information on Websites, see one of these Web pages. I
often use them in my handouts and with classes. Both
do an excellent job of helping any Web user become
more discriminating in their evaluation and use of
these resources.

� “Thinking Critically about World Wide Web
Resources” from the UCLA Library:
http://www.library.ucla.edu/libraries/college
/help/critical/index.htm

http://www.lib.umn.edu/
http://www.library.ucla.edu/libraries/college/help/critical/index.htm
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� “Evaluating Web Resources” from Widener
University: http://www2.widener.edu/Wolfgram-
Memorial-Library/webevaluation/webeval.htm

Won’t get fooled again
Even Sherlock Holmes would find the Web a sticky
wicket. For example, imagine looking for information
on gun control. If you checked out the site of
L.A.R.G.O (Lawful and Responsible Gun Owners) or
the National Rifle Association of America, you would
find very different information than you will by going
to, for example, the Center to Prevent Handgun
Violence.

• LARGO: http://www.largo.org
• NRA: http://www.nra.org
• Handgun control: http://www.handguncontrol.org

Abortion, capital punishment, animal research, censor-
ship and prayer in school are other good examples of
issues where the coverage and opinions you get will
vary greatly depending on where you go on the Web.

❚❚ The first principle is that you must
not fool yourself, and you are the easiest
person to fool. ❚❚ Richard Feynman

An often-cited example of Websites established to
‘fool’ users as a way to stress the importance of Web
evaluation is the “Mankato, Minnesota Home Page:
Its natural wonders, history and culture,” which
provides town and tourism related information on
Mankato like you’ve never seen before: http://
lme.mankato.msus.edu/mankato/mankato.html

Another one worth a look is an article on “Feline
Reactions to Bearded Men” which purports to be from
the humorous journal, Annals of Improbable Research:
http://www.improbable.com/airchives/classical
/cat/cat.html

❚❚ You can fool too many of the people
too much of the time. ❚❚ James Thurber

Check out the Mankato and feline Websites. Yes, they
are funny; but a careful look will show how easily the
look-and-feel of a Website can fool or influence the
casual Web user.

Sorting out the forgeries
Do you still think Web research is a no-brainer? If so,
then check out the King Center Website, established
by Coretta Scott King: http://thekingcenter.com

Now take a good look at this site
<http://martinlutherking.org> which was created to
have the look-and-feel of the King Center site. This
Website, however, was created by the white-suprema-
cist group Stormfront, and it contains a variety of
erroneous and/or misleading information. There is
nothing on the Stormfront site which either clearly
identifies its position/purpose or its source/sponsor.

❚❚ It has long been an axiom of mine that
the little things are infinitely the most
important. ❚❚ Sir Arthur Conan Doyle
(Sherlock Holmes) A Case of Identity,
1892

Sometimes even the experts are fooled. During the
Kosovo war in June 1999, a news item – widely
reported on CNN and elsewhere – stated that former
Joint Chiefs of Staff Chairman John Shalikashvili had
posted a 2,000 word essay on the Web that attacked
Clinton’s handling of the Kosovo conflict. In reality,
the Website was a fraud and Shalikashvili (who was out
of town fishing the weekend that the news reports
surfaced) had to issue statements denouncing the
posted report as a forgery. The news reporters them-
selves were fooled by the Website, reporting this as fact
– so, it can happen to anyone.

Where can you go for help?
If you need to improve your Web IQ or find ways to
help your students become more sophisticated users of
the Web, contact one of the libraries here on campus.
Trained library staff will be happy to help you indi-
vidually, refer you to library-sponsored workshops on
Web research, or even come to your office or class to
give you or your students a brief tour of the Web.

� Communications about this column should be
addressed to: Nancy K. Herther, Social Sciences
Bibliographer, 170b Wilson Library, West Bank;
612-624-2020; n-hert@umn.edu

❚❚ The case has, in some respects, been not
entirely devoid of interest. ❚❚ Sir Arthur
Conan Doyle (Sherlock Holmes) A Case
of Identity, 1892

http://www2.widener.edu/Wolfgram-Memorial-Library/webevaluation/webeval.htm
http://www.largo.org/
http://www.nra.org/
http://www.handguncontrol.org/
http://lme.mankato.msus.edu/mankato/mankato.html
http://www.improbable.com/airchives/classical/cat/cat.html
http://thekingcenter.com/
http://martinlutherking.org/
mailto:n-hert@umn.edu
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Books in Print & Ulrich’s Periodical Directory
New On-line Resources from the Libraries
Kate McCready, Wilson General Reference Service, http://www.lib.umn.edu

T he University Libraries have acquired two
new on-line resources for campus wide
access for the next year: Books in Print and
Ulrich’s Periodical Directory.

How to Access

Go to LUMINA, the University Libraries’ Web page:
http://www.lib.umn.edu

Select “Reference Sources.”

Then click on “Books, Periodicals, and Publish-
ing.” Both new databases are listed there
(available only to students, faculty, and staff
of the University of Minnesota, unless you are
accessing these from a U of M campus library).

� Books in Print
While this standard reference work has been available
on-line for several years through the University of
Minnesota Bookstores, their version does not allow for
publisher searches or complicated combination
searches, such as subject and author. The Libraries
have now subscribed to this resource from Bowker, the
corporation that compiles the data and publishes the
print version. This new access brings several advanced
search features that have been in demand.

Booksinprint.com is comprised of the following print
titles: Books in Print; Books Out-of-Print; Children’s
Books in Print; Forthcoming Books; Bowker’s Pub-
lisher Authority Database; Bowker’s Complete Video
Directory; and Words on Cassette. The database
includes:

• Over 3.5 million title records
• 165,000 records on publishers, distributors,

wholesalers and book agents

• Information on award winners, bestsellers and
more

• Over 500,000 full-text reviews
• E-mailing and downloading capabilities

Searching
Searching Bowker’s Books in Print could not be easier.
The Quick Search feature allows you to perform a
search on a keyword, a title, an author or an ISBN
(International Standard Book Number) from the home
page. You could also browse the database by major
subjects or browse by several indexes including author,
title or publisher. The Advanced Search interface gives
you many options for performing simple and complex
searches.

The display record of a book is very complete. It
provides you with the physical information, page
numbers, prices (hard and soft cover), author and
publisher.  The display also supplies links to the
publisher’s information and allows you to quickly
search for other works by the author.

There are over 500,000 full-text reviews provided in
the database, and summaries of many of the titles are
available as well. You can easily select individual or
multiple titles for displaying, printing, downloading
and e-mailing.

Searching for publishers is one of the nicest features of
this database. Publisher records not only provide you
with a list of the titles in print that they have pub-
lished, but also shows you the contact information and
address of the publisher and, when available, provides a
link to their home page.

Book Room and other services
Forthcoming Book Room is another service provided
by Bowker. This section presents you with information
about books that are to be published soon, but are not

❚❚ Any intelligent fool can make things bigger and more
complex...it takes a touch of genius — and a lot of courage —
to move in the opposite direction. ❚❚ Albert Einstein

http://www.lib.umn.edu/
http://www.lib.umn.edu/
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yet in print. There are also several entertaining seg-
ments to this service.

• “In the Media” allows you to browse books that
have been highlighted by recent television and
radio shows (Oprah, NPR, etc).

• “Publisher’s Spotlight” shows you new titles that
publishers are trying to showcase.

• “Bowker Bookwire” provides book industry news,
guides to literary events and author tour informa-
tion.

• “Bowker’s Children’s Room” provides access to
thousands of books, audiocassettes and videos for
children and young adults. You can search by age,
grade, subject, setting and more.

• “Bowker’s Fiction Room” allows you to search for
fiction titles by character. It also recommends new
titles based on fiction works that you know you
like.

All information in this database is supplied to Bowker
from individual publishers. Bowker updates the on-line
database daily.

� Ulrich’s Periodical Directory
This is a completely new resource available to the
University community. Ulrichsweb contains nearly a
quarter-million serial (periodical) records, including:

• Academic and scholarly publications
• Consumer magazines
• Electronic publications
• Monographic series
• Newsletters
• Newspapers
• Trade publications
• ‘Zines

And many other types of serial publications — whether
published regularly or irregularly, and whether they’re
active, ceased or forthcoming publications. You can
search by the current title, the previous title, the
announced title and even the translated title.

Because Bowker provides our access to this database,
the same search features exist here as in Books in Print.
You can perform a Quick Search on a keyword, the
title or ISSN (International Standard Serial Number).
You can also go to the Advanced Search.

Each title in the Ulrichsweb database is displayed in
two ways — briefly on the Search Results screen and in
more detail on the Full Display, which is divided into
as many as six tabbed areas:

1. Full Description
provides complete bibliographic data on the title,
plus hyperlinks to e-mail addresses, URLs and
other titles in the same subject category.

2. Other Editions/Formats
tells whether a title is available in an electronic
format (such as on-line or on CD-ROM); has an
edition in another language; has a supplement; or
has other related titles.

3. Document Access
tells you who provides A&I, document delivery or
reprint services for a title.

4. Publisher and Ordering Information
provides address and contact data for the pub-
lisher, editorial sponsors, and ordering, subscrip-
tion or distribution offices.

5. Advertising, Rights, Demographics
tells who to contact for advertising information or
rights to use information from a serial.

6. Reviews
lists full-text reviews from Magazines for Libraries
and/or Library Journal.

Lighthearted features
There are also some lighthearted features of this
database. These segments include the Periodicals
Reading Room and the UlrichsWeb News.

• The Reading Room highlights different groupings
of titles. The latest group that they highlighted was
Spanish language titles that are available on-line.

• The News section focuses on current hot topics in
the field of serial publishing. The latest topic
examined how close we are to the age of all-
electronic journals.

Links to Books in Print and Literary Market Place.com
are also provided on Ulrich’s home page.

� Kate McCready, General Reference, Wilson
Library, 180 Wilson Library, West Bank
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UCS: University Computer Services
Moving in May to 2218 University Avenue

A fter anticipating the move for
months, May is nearly here!

Barring a natural disaster, the
2218 building completion date is
scheduled for mid-April, and the
actual UCS move is scheduled for
the first week of May. The UCS
Website will post moving details as
they become available:
http://www.umn.edu/ucs

UCS will continue to offer services,
but there may be a slight delay
during the week of the move. Call
UCS at 612-624-4800 for more
information; the UCS phone number
won’t change.

Why move?
• The newly remodeled building

will be a more convenient East
Bank location.

with a complete line of computer
support and services, available
from one point of contact. UCS
offers short-term and long-term
service options, such as:

• Computer software consulta-
tion and support

• UNIX support and consultation
• Server support and file

storage
• Used computer pick-up and

recycling
• Computer hardware support

and upgrades
• Computer training

Same phone number
UCS will have the same phone
number at the new location:
612-624-4800

� Renee Halvorson, University
Computer Services

• UCS customer parking will be
available on the east side of
the building.

• There will be a bigger used
computer showroom.

• The building houses various
departments from the Office of
Information Technology (OIT).
This will enable us to provide
more of a complete technology
service.

Where is 2218 University?
The building is located at the
intersection of Huron Blvd. and
University Ave. See the UCS Web-
site for a map:
http://www.umn.edu/ucs

What services are offered?
UCS pools the resources of key
technology units to provide the
University of Minnesota community

http://www.umn.edu/ucs/
http://www.umn.edu/ucs/
http://www.umn.edu/ucs/


� Web and Internet Addresses Quick Guide

Information Technology Newsletter
http://www.umn.edu/oit/newsletter

Internet/Email account management/validation
http://www.umn.edu/validate

MNCAT/LUMINA (Library) –  http://www.lib.umn.edu
Office of Information Technology
http://www.umn.edu/oit

Onestop Services – http://onestop.umn.edu
Techmart – http://www.techmart.umn.edu
UM News Server – news.tc.umn.edu

� General Phone: Area Code = 612
Threats, UM Police Department .................. 911 on campus

• off campus................................................... 624-3550
Technology Training Center ................................. 625-1300

• web: http://www.umn.edu/adcs/info/training.html
Computer Accommodations Program–voice/tty ... 626-0365
U Computer Services/Computer Repair Serv ...... 624-4800
Digital Media Center ........................................... 625-5055
Statistical Software Support:

including SAS and SPSS ................................. 624-3330

Associate Vice President and
Chief Information Officer, Steve Cawley ....... 612-625-8855

� Help Phone: Area Code = 612
Computer Misuse or Abuse (also see Procedure 2.8.1.1)

• Emergency Network Help Line ...................... 625-0006
• Non-emergency, e.g., spamming: abuse@tc.umn.edu

1 Help •7/24/365, unless otherwise noted ..... 301-4357
� CCO: central systems, PeopleSoft

• web: http://www.umn.edu/cco
• by email: x-help@cafe.tc.umn.edu

� Internet, Email, Microcomputers,Distributed Systems
• call-in Monday–Thursday • 8 am–11 pm
• call-in Friday • 8 am–5 pm
• call-in Saturday • noon–5 pm
• call-in Sunday • 5 pm–11 pm

• walk-in 8 am–5 pm, M–F:
152 Shepherd Labs; 93 Blegen; 50 Coffey Hall

• web: http://www.umn.edu/adcs
• by email for U of M: help@tc.umn.edu

� Passwords: new and forgotten ones
� NTS-TAC: Technical Assistance Center

• web: http://www.nts.umn.edu

� Dial-in Computer Access
Internet/PPP/SLIP: up to 53kps if v.90 ....... 612-627-4250

(56k K-flex, Flex56, X.2 protocols are unsupported)
Modem Usage (current activity on your account)
www.nts.umn.edu/services/modemusage.html
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please tell us the Rec#.
Just tear off the end page
and send the entire mailing
label to us. Or send email to:
oitnsltr@tc.umn.edu

Twin Cities campus address label trivia: the 2nd number after the Rec# is the Campus Mail delivery code, http://umn.edu/lookup

Newsletter subsciption information and archives at http://www.umn.edu/oit/newsletter


